
Music Toolkit FAQ 
For the latest version of this document please go to www.2simple.com> support  

 

Sound Problems  

Q: I can't get sound working on my computer  

Q: There is no sound in 2Explore / 2Beat / 2Sequence  

Q: There is no sound in 2Play / 2Compose / 2Synthesise  

Q: Error when trying to open 2Play / 2Compose / 2Synthesise – “Change to autowait…” 

Q: I changed the MIDIdevice in 2Play as you suggested, but 2Compose closes before I have a chance  

Q: The music does not play back with the right timing 

Saving and opening 

Q: “Sorry. This file could not be saved here” when saving 

Q: When I try save my work, the program defaults to C:\Program Files… instead of My Documents 

Q: I press save but am not able to choose which folder to save to 

Q: How do I change the default save and open folder? 

Q: I double-click on a saved Music Toolkit file and it opens the program but not the file itself 

Saving as WAV or MIDI 

Q: Can I save files in a standard music format? 

Q: How do I save as Wav or MIDI? 

Q: The sound plays back ok in the program, but when I save it as a WAV file, it is silent – or the wav file 

records my voice as well as the music? (2Explore / 2Beat) 

Q: How to use Windows Sound Recorder with the Music Toolkit 

Q: 2Sequence has no option to save as a standard music file format? 

Q: 2Beat leaves out some beats when saving as to wav 

Printing 

Q: I change the printer in the teacher options but this does not get remembered? 

Q: When printing, only the notes on the current page are printed 

Q: “Run-time error 13: Type mismatch” when trying to print 

2Sequence 

Q: How do “My Sounds” work in 2Sequence? 

Q: 2Sequence does not display any sound icons at the bottom of the screen 

2Compose 

Q: In 2Compose, I am unable to place 4 beats in a 4/4 bar 

Q: In 2Compose, I cannot add a “rest” symbol 

Q: In 2Compose, I cannot view all 4 staves 

2Synthesise 

Q: Where are files saved in 2Synthesise? 

Q: When I open and close 2Synthesise, the work folder changes to C:\Program Files\... \Music Toolkit 

Q: Can I save multiple tracks simultaneously in 2Synthesise? 

Q: I’m unable to record a tune using an imported wav file 

General 

Q: The Mute button always seems to be on 

Q: My keys keep sticking down & playing continuously 

Q: Can I add my own sounds in Music Toolkit? 

Q: Can I use the keyboard only when using Music Toolkit? 

Q: Is there a minimize button? 

Q: “Run-time error '339': Component 'Flash.ocx' or one of its dependencies...” 

Q: The program does not display correctly on a wide screen resolution 

 

 

Sound Problems  

 

Q: I can't get sound working on my computer  



1) First check that other programs (not related to 2Simple) work with sound on your computer. 

2) Another good test is to try play the videos which accompany the Music Toolkit.  

3) If you don't get sound, check that you have your speakers plugged in to the computer and turned on. 

4) Make sure your volume controls are all turned up. Pay particular attention to the “master volume” slider 

control, as well as “sw synth” for 2play, 2compose and 2synthesise, and “wave” for 2explore, 2beat and 

2sequence. 

5) If you still do not get sound with any program, your computer may not have sound set up correctly. 

Please report this to your technician. 

 

Q:There is no sound in 2Explore / 2Beat / 2Sequence  

A: These 3 modules use sound files in WAV format. Try the following : 

1) Double-click on the speaker icon on the bottom right corner of your screen(If you do not see it, click Start 

>Control Panel >Sounds and tick "show volume control on taskbar") 

2) In the window which appears, make sure all volume sliders are at maximum and none are muted out. Pay 

particular attention to the slider control entitled "Wave". 

3) Additionally, click on "options" (on the top left corner of the sound control panel) and then "properties". 

The window which should appear allows you to display additional volume sliders which may not be 

displayed yet - to display all available volume sliders, make sure all the boxes are ticked, then click ok. 

4) Do not get confused between sound controls for PLAYBACK and sound controls for RECORDING. Playback 

and recording have separate slider controls, and you can switch between them using options > properties. 

5) If none of the above works, try double-checking Wav works on your computer : 

1) Click Start - Programs - Accessories - Entertainment - Windows Media Player 

2) Click File – Open and navigate to C:\Windows\Media and select a .wav file (such as "chimes") 

3) Press play in Windows Media Player. 

4) if you have a problem hearing this file, you need to look at how sound is set up on your computer 

as you should be able to hear it irrespective of whether 2Simple Music Toolkit is installed or not. 

 

Q: There is no sound in 2Play / 2Compose / 2Synthesise  

A: Note that these 3 modules use MIDI technology and so will not work on a thin client system. If you’re 

not using a thin client system and still have this problem, changing the MIDI Device will usually fix this issue. 

(You need to have version 1.0.90 or later to do this. To check your version, look at the little pop-up window 

that appears when you launch any of the 6 music programs - on the top left will be the version number. If 

you do not have version 1.0.90 or later, contact 2Simple and we will send you a download link.) Open 

2compose, go into the teachers options (ctrl + shift + O) and select "settings" tab. Change the MIDI device 

used. Each time you change the selection, it should immediately play the notes "C-D-E". If it does not do 

this, try select another MIDI driver, until you have one which works.You can also do this in 2play, and the 

MIDI Device setting you choose in 2play will affect 2synthesise also.If changing the MIDI Device does not fix 

the problem, try double-checking MIDI works on your computer : 

1) Click Start - Programs - Accessories - Entertainment - Windows Media Player 

2) Click File – Open, and navigate to C:\Windows\Media  

3) Select a .mid file (NOT a .wav file) - for example Bach's Brandenburg Concerto No. 3 

4) Press play in Windows Media Player. 

5) If it works, you can play MIDI files on your computer - go back to 2play one more time and see if 

you get sound (sometimes you need to play a midi file first in Windows Media Player to “initialize” 

midi files, before it will work in 2play / 2compose / 2synth.) 

6) If it does not work, your computer may have a problem with playing MIDI files. Please check how 

sound is set up on your computer or refer this problem to your technician. 

 

Q: Error when trying to open 2Play / 2Compose / 2Synthesise – “Change to autowait…” 

A: Refer to solution as described in the previous question. 

 

Q: I changed the MIDIdevice in 2Play as you suggested, but 2Compose closes before I have a chance  

1) Double-click My Computer and go to C:\Program Files\2Simple Software\Music Toolkit 

2) Open the file "2mt.ini". This will open in notepad. 



3) Under the [2play] section will be an entry "midiDriverNumber=..." 

- you need to make the same entry for 2compose - add a line to the bottom of the file and type in 

"[2compose]" excluding quotation marks, including square brackets.  

4) Under that line, add a second line with the same "midiDriverNumber=..." as for 2play 

5) save the file and exit, then try 2compose again. 

 

Q: The music does not play back with the right timing 

A: With 2Explore, 2Beat, and 2Sequence try the following: Go to the teacher options (ctrl + shift + the letter 

“o”), select the General tab, and in the “Playback method” dropdown choose “B-Alternative” instead of “A-

Normal”. If this option does not appear in your teacher options, you may have an old version – contact us 

for a download link of the latest version. 

 

 

Saving and opening 

 

Q: “Sorry. This file could not be saved here” when saving 

A: The program is trying to save to a location which it does not have permissions to. This location is 

probably C:\Program Files\2Simple Software\Music Toolkit, which is the default save location for Music 

Toolkit v1.0.90. Contact 2Simple for a download link of the latest version which defaults to the My 

Documents folder.  Alternatively, you can edit the default save path with the version you already have – see 

below.  

 

Q: When I try save my work, the program defaults to C:\Program Files… instead of My Documents 

A: You most likely have an older version of the program installed. Contact 2Simple for a download link of the 

latest version which defaults to the My Documents folder.  Alternatively, you can edit the default save path 

with the version you already have – see below.  

 

Q: I press save but am not able to choose which folder to save to 

A:  Open the Music Toolkit. Go into the teacher options (ctrl + shift + the letter “o”) from one of the 

programs such as 2Play, select the GENERAL tab and click the button on the bottom right with 3 dots on it. 

Select STANDARD dialogs on the bottom left and click OK and OK again. You will need to repeat this for each 

of the 6 parts of the Music Toolkit. You may need to be logged in as administrator for this setting to be 

remembered. You’ll need to make this change on each computer (for more info, see www.2simple.com> 

support > networks > copying 2Simple settings across a network).  

 

Q: How do I change the default save and open folder? 

A: Open the Music Toolkit. Go into the teacher options (ctrl + shift + the letter “o”) from one of the 

programs such as 2Play, select the GENERAL tab and click the button on the bottom right with 3 dots on it. 

Navigate to the folder you want. You can also change the drive by clicking the down arrow on the right of 

where the drive is listed. Click OK. Once you have done this for 2play, it will also work for 2explore, 2beat 

etc. You may need to be logged in as administrator for this setting to be remembered. You’ll need to make 

this change on each computer (for more info, see www.2simple.com> support > networks > copying 

2Simple settings across a network). You can set the default work folder in the teacher options for any of the 

6 parts of the Music Toolkit except for 2Synthesise, although 2Synthesise does default to the save folder if it 

is set within any of the other 5 programs. 

 

Q: I double-click on a saved Music Toolkit file and it opens the program but not the file itself 

A: You need to open up saved files using the OPEN button within the Music Toolkit. This program does not 

support opening files by double-clicking them from outside the program. 

 

Saving as WAV or MIDI 

 

Q: Can I save files in a standard music format? 

A: Yes. 2Explore and 2Beat can save as a WAV file, and 2Play, 2Synthesise and 2Compose can save as a MIDI 



file. See below for more information about 2Sequence. 

 

Q: How do I save as Wav or MIDI? 

A: When you click save, you should get a tickbox to save as wav (in 2Explore and 2Beat) or as midi (in 2Play, 

2Synthesise and 2Compose).  This is if you have SIMPLE save dialogs enabled (simple save dialogs show a 

simplified window which does not allow browsing to different folders.) If you have STANDARD save dialogs 

enabled, there will be no tickbox but you can choose to export as wav or midi by clicking on the “save as 

type” dropdown. If no wav or midi option shows in the dropdown, you need to get the latest version from 

2Simple – please contact us for a download link. If you want to switch between simple and standard dialogs, 

open the teacher options (press ctrl + shift + the letter “o” – not from the launcher but from one of the 6 

programs, such as 2Play) and click the General tab and then the button with the 3 dots on the bottom right. 

 

Q: The sound plays back ok in the program, but when I save it as a WAV file, it is silent – or the wav file 

records my voice as well as the music? (2Explore / 2Beat) 

A: Make sure to record sound from the computer and not the microphone: 

Windows XP 

Double-click the speaker icon on the bottom right corner of your screen (If you do not see it, click Start > 

Control Panel > Sounds and tick "show volume control on taskbar"). Click Options > Properties and make 

sure you have RECORDING selected (If it is greyed out, you may need to change the mixer device from the 

dropdown at the top). Make sure all the boxes at the bottom are ticked and click OK. You should now see 

the “Recording Control” window. Make sure “Stereo Mix” is selected, and NOT microphone. 

 

 
 

Now re-open one of the Music Toolkit files, then save as a WAV file again.  

Windows 7: 

1. Right click on the audio icon in the task tray 

2. Choose “recording devices” 

3. Right click and ensure there is a tick in the box which says “Show disabled devices” 

4. Stereo mix should now appear (if it does not appear, you may need to update your sound card 

driver. Speak to your technician for help with this.) 

5. Right click Stereo mix and press “Enable” 

6. Right click Stereo mix again and press “Set as default device” 

7. Now re-open one of the Music Toolkit files, then save as a WAV file again.  

 

Q: How to use Windows Sound Recorder with the Music Toolkit 

A: As an alternative to using the Music Toolkit’s own export as wav or midi options, you can also use 

Windows Sound Recorder to convert a file into wav format. However this method is quite technical and not 

recommended for pupils. 

1. Make sure to record sound from the computer and not the microphone (see previous question for 

how to do this) 

2. Create or open your Music Toolkit sound file. 



3. Click Start > Programs > Accessories > Entertainment > Sound Recorder.  

4. Press the red circle to start recording, and then switch to the Music Toolkit sound file and press play. 

When the file has finished playing, switch back to the sound recorder and press stop (holding down 

ALT and pressing TAB is one way to switch between open applications)  

5. Within Windows Sound Recorder, you can click Edit > Delete before/after current position to trim 

the start and end of the recording (although it looks like these have options have been removed in 

Windows 7 – see this post about ways around it - http://answers.microsoft.com/en-

us/windows/forum/windows_7-windows_programs/why-win7-sound-recorder-dont-have-the-

functions/99e2d634-14d8-4100-b910-0d04d7a0c52a  ) 

6. In Sound Recorder, click File > Save to save as a wav file. 

 

Q: 2Sequence has no option to save as a standard music file format? 

A: Unfortunately it does not. The only current workaround is to use Windows Sound Recorder – see 

question above.  

 

Q: 2Beat leaves out some beats when saving as to wav 

A: Occasionally on some computers when saving a 2beat file in wav format, the resulting file has some beats 

missing from the end. If this is a persistent problem, a potential workaround for this it to use Windows 

Sound Recorder – see question above. 

 

Printing 

 

Q: I change the printer in the teacher options but this does not get remembered? 

A: Unfortunately, changing the printer in the teacher options does not update the “2mt.ini” settings file, 

which does not store a default printer setting. So any changes you make to the printer choice in the teacher 

options will be applicable while the program is currently open, but the next time you run the program it will 

revert to the Windows default printer.  

 

Q: When printing, only the notes on the current page are printed 

A: 2Play: If the recorded notes are longer than one page, to print the 2
nd

 page you must play the recorded 

file until the 2
nd

 page is displayed, then pause the playback and press print. 

2Sequence: if you are working on a 32 or 64 length sequence, the program will only print the section of the 

sequence which is visible; to print a different section, you need to scroll to it first and then press print.  

2Compose : use the magnify buttons on the bottom left corner to choose the zoom level before printing. 

 

Q: “Run-time error 13: Type mismatch” when trying to print 

A: This error can happen if you have no printers installed and you try to print.  

 

2Sequence 

 

Q: How do “My Sounds” work in 2Sequence? 

A: The My Sounds tab looks in your work folder for any wav or midi files and automatically displays them in 

the tab, for use in 2Sequence. The work folder location is by default your “My Documents” folder, but can 

be customized in the teacher options (press ctrl + shift + the letter “o”) in the “store files in” section. (You 

can change the work folder location from any of the Music Toolkit programs except 2Synthesise. Once you 

have made the change it will affect all 6 Music Toolkit programs. The work folder location is stored in the 

2mt.ini file as “StartDir=”, under the “[Files]” section. The ini file stores the Music Toolkit settings and is 

located where the program is installed, typically C:\Program Files\2Simple Software\Music Toolkit.)  Any 

recordings done in 2Synthesise automatically get saved as midi files to the work folder without you having 

to press save, so they will show up in the 2Sequence My Sounds folder. For the other parts of Music Toolkit, 

make sure you tick save a WAV or MIDI when saving, if you want them to show up in 2Sequence. 

 

Q: 2Sequence does not display any sound icons at the bottom of the screen 

A: If you are running the software on an RM CC4 network, try change the workstation security level for that 



computer to NONE in the RMMC. You may need to restart the workstation after you have done this. 

 

2Compose 

 

Q: In 2Compose, I am unable to place 4 beats in a 4/4 bar 

A: This could happen if, for example, you place a semi-breve at the end of the previous bar. This should 

ideally not be permitted by 2Compose, however the program in this case does allow it, and it prevents 

placing of notes at the beginning of the next bar. The “solution” is to make sure you place notes correctly on 

the previous bar.  

 

Q: In 2Compose, I cannot add a “rest” symbol 

A: Unfortunately 2Compose does not provide the facility to add this symbol. 

 

Q: In 2Compose, I cannot view all 4 staves 

A: Use the magnify buttons on the bottom left corner of the screen to zoom in or out 

 

2Synthesise 

 

Q: Where are files saved in 2Synthesise? 

A: Any recordings done in 2Synthesise automatically get saved to the work folder without you having to 

press save - the files are named 2synth tune 1.mid, 2, 3 etc. You can also choose to save/export the 

2Synthesise recordings with a differently named midi file by pressing the save button at the top left. This 

will again save to the work folder (unlike the other parts of the Music Toolkit, you cannot change the save 

dialog box from simple to standard format, so you cannot browse folders when pressing save.) 2Synthesise 

also automatically saves a file named “2synthM.2sm” in the work folder when you exit the program, and 

this stores the recordings in an internal format which allows you to re-open 2Synthesise later on and play 

back what was recorded previously. 

 

Q: When I open and close 2Synthesise, the work folder changes to C:\Program Files\... \Music Toolkit 

A: This is a known issue with 2Synthesise and happens under the following circumstances: The default work 

folder in the latest version of the Music Toolkit (v1.3) is the user’s “My Documents” folder (This is 

represented in the 2mt.ini file as “StartDir=MYDOCS”.) When you open and close 2Synthesise, it 

automatically modifies the ini file setting to be StartDir=C:\Program Files\... \Music Toolkit. Two 

workarounds to this are as follows: (1) if the user’s My Documents folder is mapped to a drive letter such as 

H:, amend the work folder (either through the teacher options or by editing the ini file directly) to default to 

the H:\ drive. When the work folder is set to any location other than “MYDOCS”, 2Synthesise does not 

overwrite this setting. (2) Alternatively, set the 2mt.ini file to be read-only and 2Synthesise will not be able 

to overwrite the setting, however the disadvantage of this method is that midi files saved by 2Synthesise 

will still get saved to C:\Program Files\... \Music Toolkit rather than the user’s My Documents area.  

 

Q: Can I save multiple tracks simultaneously in 2Synthesise? 

A: Unfortunately this is not a feature of this program. 

 

Q: I’m unable to record a tune using an imported wav file 

A: This is not an available feature of the program. (This refers to the following issue: if you are using 

2Synthesise and scroll to the right-end of the available instruments, there is a “sample” button which lets 

you import a wav file. Once you have done this, any key you press on the music keyboard plays back a 

variation of the wav file. However, if you now try record a tune using this “instrument”, nothing gets played 

back.) 

  

General 

 

Q: The Mute button always seems to be on 

A: The speaker icon with the red cross through it that appears on some of the Music Toolkit programs does 



not actually indicate that sound is not working or that sound is disabled on your computer. The icon is in 

fact a button which allows you to stop music from playing when you are in the middle of using the program.  

 

Q: My keys keep sticking down & playing continuously 

A: This is actually an intentional feature called “drone notes” or “sticky keys”. What really happens is if you 

click down with your mouse onto a key and then move off the key before you click up, the key will stick 

down and play continuously. If you click down & up without moving the mouse from the piano key, it should 

not hang. It was designed this way to enable a user to play multiple notes using the mouse only. It should 

not happen if you use your keyboard, and also pressing the “no sound” button (speaker with a cross 

through it) at the top right should “lift up” all down keys and stop any hanging sounds. 

Due to customer feedback, the current version of the Music Toolkit allows this feature to be disabled 

through the Teacher Options (Ctrl-Shift-O). Please contact us if you have an older version and would like this 

feature.  

 

Q: Can I add my own sounds in Music Toolkit? 

A: You can add sounds to 2Explore, 2Sequence and 2Synthesise, and you can change sounds in 2Beat. You 

can only do this with WAV files 

- 2Explore: Go to the location where you have installed the Music Toolkit - by default C:\Program 

Files\Music Toolkit\. Go into the GROUPS subfolder. You will see a number of subfolders, each 

representing one option when you press NEW from within 2Explore. You can create additional 

folders which will also be displayed in this way. All you need in the folder is 6 WAV files named 1 to 

6, as well as 2 BMP files per WAV file - one for "off" and one for "on" – (the picture will change 

when you click your mouse on it within 2Explore.) Take a look at the existing folders to see how this 

is done. 

- 2Sequence: - Go to the location where you have installed the Music Toolkit. Go into the SEQ 

subfolder. You will see a number of subfolders, each representing a different group within 

2Sequence. Simply add a new WAV file and a BMP file with the same name to any of these folders, 

and 2Sequence will pick this up automatically. Don't create a new folder.  (Additionally, if you record 

something in 2Synthesise, it should automatically show up in the My Sounds folder of 2Sequence.)  

- 2Synthesise: Scroll the music instrument panel to the right until you get to the SAMPLE button in 

the OTHERS category.  Click on sample and browse to your saved WAV file. Select the file and click 

open. Hold a note down with the keyboard or mouse to play the file.  

- 2Beat: Sounds cannot be added but you can replace existing beats in the DRUMS folder with any 

other WAV file.  

- 2Compose: Add sounds by adding BMP files to the MIDI folder with name of instrument and midi 

number. This is an advanced option. 

 

Q: Can I use the keyboard only when using Music Toolkit? 

A: To a limited extent, yes. See the Switch Access section of the General FAQ in www.2simple.com> support. 

 

Q: Is there a minimize button? 

A: No, the programs in the Music Toolkit do not have a minimize button. Two of the six programs (2Beat and 

2Synthesise), however, can be resized to be smaller and moved to different parts of the screen. Click on the 

maximize/unmaximise button just to the left of the exit button. Now you can move the program window by 

clicking and dragging the program titlebar (and most other areas of the program window). You can resize by 

clicking and dragging on the bottom right corner of the program window. 

 

Q: “Run-time error '339': Component 'Flash.ocx' or one of its dependencies...” 

A: Please install the latest Adobe Flash Player from www.adobe.com  

 

Q: The program does not display correctly on a wide screen resolution 

A: Yes, some parts of the Music Toolkit do not display correctly on certain wide screen resolutions, although 

by and large the program is still usable on these resolutions. For example, the instrument circles in 2Explore 

may overlap and the recording panel in 2Play may be squashed. 
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